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         About This Manual

          This manual is divided into six sections:

           Introduction           Installation and introductory information
           Commands               A brief overview of the WinCheck commands
                                  (menu items)

           Starting A New Account Information for starting your first
                                  WinCheck account
           Using WinCheck         Information on using  WinCheck's features

           Tips and Techniques    Helpful hints and techniques to using
                                  WinCheck
           How To                 A list of "How To's" on using WinCheck.

           Appendix               WinCheck messages and meanings.
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         Introduction

          WinCheck is a checkbook management program for Microsoft Windows
          Version 3.00.  With WinCheck it is possible to enter and track the
          following transactions for multiple savings and checking accounts.

          Transaction Types

            Check Writing and/or Withdrawal from Savings
            Deposits
            Interest Accrued
            Cash Machine Advances
            Misc Bank Charges
            Transfers to or from Savings and Checking

          WinCheck will manage all of these transactions, making it easy to
          balance your checkbook and record a savings account's history.

          System Requirements
            WinCheck requires an IBM PC or compatible with a minimum of 640K
            memory running Microsoft Windows version 3.00 or higher.

          Acknowledgements

            WinCheck was designed and written by Dave Edson.
            User's Manual designed and written by Kate Edson, with a tiny bit
            of help from Dave Edson.

            WinCheck OnLine Help by Don Hasson
            Special thanks to all who sent comments and suggestions, helping
            to make WinCheck as useful and easy to use as possible.
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          WinCheck Installation
            The installation program for WinCheck is a Windows application,
            so Windows will need to be running prior to running the Setup
            program.  To start the Setup program, put the appropriate disk
            into the floppy drive and from the File menu of the Windows
            Program Manager choose Run.  Beside the words "Command Line:",
            type the drive that contains the floppy disk followed by the
            filename SETUP.EXE (i.e. A:\SETUP.EXE).  This will start the
            WinCheck setup program.

            Setup prompts you for a location to install WinCheck (i.e.
            C:\WINCHECK) and copies over all of the necessary files to this
            location.  Near completion of the Setup program, a Program Group
            called WinCheck is created (if your Windows shell is the Program
            Manager).

          Where Should I Begin?

            A good place to start learning WinCheck is with the tutorial
            files.  The WinCheck tutorial file includes sample data for
            January,February and March of 1991.  To access this file start
            the WinCheck program and type "TUT" for the Account ID.  With the
            tutorial file, experiment with the different features via the
            "Toolbox"; selecting the Toolbox menu toggles the Toolbox on and
            off.  Go ahead and write some fake checks, make that lottery
            check deposit you've always wished for, and get a good feel for
            WinCheck before entering your own data.
            View the check register and statement for January and February by
            selecting Display Check Statement or Display Check Register from
            the File menu (select January or February from the list of
            months).  Choose Tile from the Window menu and view information
            from January and February at the same time.

            Once you have experimented with the tutorial file and you want to
            start your own account, choose Load Account from the File menu
            and type in an account ID (i.e. your initials) or type in a new
            account ID on startup of the WinCheck program.
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          Files Included with WinCheck
            WINCHECK.EXE     The WinCheck program file

            WINCHECK.HLP     The WinCheck Windows help file
            CHKHDR.TUT       The main file for the TUT account
            CHKHDRB.TUT      A backup of the CHKHDR.TUT
            NATURES.TUT      The file containing the transaction types (i.e.
                             Personal/Business/Rent) for the TUT account.

            COMMON.TUT       The file containing "common transactions" for
                             the TUT account
            JAN91.TUT        TUT account transactions for the month of
                             January 1991
            FEB91.TUT        TUT account transactions for the month of
                             February 1991
            MAR91.TUT        TUT account transactions for the month of March
                             1991

            DETAILS.TUT      Contains the deatils of the TUT files
            SPLITS.TUT       Contains information about split transactions.
            EXP0191.TUT      A tab delimited text file created with the
                             WinCheck Export function
            *.WCT            Files created with the WinCheck Form Designer

     WINBATCH.DOC     This manual in ASCII format

            All account information is stored with the file extension of the
            account ID (requested upon startup).  This way it is possible to
            have multiple accounts, each with it's own account ID.

            Valid account ID's are 1-3 characters in length, only A-Z, 0-9
            characters are allowed.
            Each month is limited to 500 total transactions (includes
            deposits, checks, misc...).
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         Commands

          An Overview of the WinCheck Commands

            Menu choices with an asterisk* are only available at certain
            times.

            The following is the menu bar for the WinCheck Window:
            FILE
            DATA
            CHECKING
            SAVINGS
            TOOLBOX   (mouse required)
            WINDOW*
            COMMON*
            HELP

            The following is the menu bar for the Form Designer Window:

            FILE
            HELP

            The underlined character indicates the ALT key combination for
            keyboard usage, i.e. ALT+F to activate the File menu without the
            use of a mouse.  The Toolbox menu is a toggle; click on Toolbox
            menu to activated and deactivate the Toolbox (the Toolbox can
            also be deactivated with the keyboard by pressing ALT+SPACEBAR,
            C).
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          Dialog Boxes
             LOAD                Prompts for an Account ID to load a
                                 new/different account.  Previous accounts
                                 are automatically saved and closed with
                                 another account is loaded.

             TRANSACTIONS        These dialogs are the actual transactions
                                 (i.e. cash machine withdrawal).
                                 Transactions are accessed from the Checking
                                 and Savings menus or by using the Toolbox.
             PICK A MONTH        Prompts for a month to display a Register
                                 or Statement.
             EDIT/DELETE         Allows editing of Common Transactions.
             FIND                Prompts for information to find a
                                 transaction.

             SETTINGS            Prompts for program wide
                                 preferences/settings.
             CURRENT BALANCE     Displays Current Balance.
             FORM ATTRIBUTES     Defines the actual check form for printing
                                 checks.  Here you indicate the size of the
                                 piece of paper.
             CHECK FIELD ATTRIBS Defines a particular field on the check
                                 form.  For example, you can define the size
                                 and position of the date field on a check.

             TRANSACTION DETAILS Details about a transaction, such as memo
                                 lines, address of recipient, and comments
                                 are entered through this dialog box.
             SPLIT               When splitting a transaction over multiple
                                 categories (such as Personal and Business),
                                 this dialog will assist in accurate
                                 recordkeeping.
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             EDIT CATEGORIES     If a category name needs to be changed or
                                 deleted, this dialog will help you quickly
                                 accomplish the task.

             REPORT GENERATOR    Reports on your account can be printed or
                                 previewed through this dialog.
             SELECT PRINTER      WinCheck by default uses your default
                                 printer.  If you wish to use different
                                 printers for checks or reports, you can
                                 indicate this here.
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            Menus and Menu Items
            FILE (WinCheck Window)

             Load Account         Brings up the Load dialog to load a
                                  different or new account.
             Check Register       Brings up a check register for a specified
                                  month.

             Check Statement      Brings up a bank statement for a specified
                                  month.
             Current Balance      Brings up the Current Balance dialog.
             Close*               Closes the current Register/Statement
                                  window.
             Find                 Brings up the Find dialog.

             Edit Categories      Brings up the Edit Categories Dialog.
             Report Generator     Brings up the Report Generator dialog.
             Export*              Exports the active register window to a
                                  tabbed text file which can then be
                                  imported into a spreadsheet program such
                                  Microsoft Excel, Lotus 1-2-3, Quattro
                                  etc....
             Check Form Printer...Used to bring up the WinCheck Form
                                  Designer.

             Select Printers...   Brings up the Select Printers dialog.
             Windows Printer...   Brings up the standard Windows Printer
                                  Setup dialog.  Consult your Windows manual
                                  for usage.
             Settings             Brings up the Settings dialog to store
                                  user preferences.
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             FILE (Form Designer Window)

             New Form Template    Clears the workspace for a new template.
             Load Form Template   Loads and selects a form template.
             Save Form Template   Saves a form template.

              Save & Add...       Saves the template, and adds it to your
                                  template list.
             Form Attributes      Activates the Form Attributes Dialog
             Print Test Form      Prints a Test Form
             Go Back to WinCheck  Returns to WinCheck Main Window
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            DATA*

            Print Checks          Prints the selected check(s) from the
                                  active register.
             Sum Highlighted      Amts Sums the selected transactions from the
                                  active register, and displays the amount.
             Clear                Tags selected transaction(s) in the Check
                                  Register or Statement as cleared by the
                                  bank.  When the transactions have been
                                  cleared, they appear with an asterisk
                                  beside the date and dollar value.  The
                                  "BnkChk" or "BnkSav" columns in the Check
                                  Register  indicate the "Banks opinion" on
                                  your account.

             UnClear              Toggles "cleared transactions" to
                                  uncleared (no asterisk).
             Delete               Deletes selected transaction(s).from the
                                  Check Statement or Register (deleting a
                                  transaction from either the Statement or
                                  the Register will also delete the
                                  transaction from the corresponding
                                  Statement or Register).
             Display Uncleared    When checked, only the transactions that
                                  have been marked as  "cleared" will
                                  display in the Check Statement.
             Headings             Toggles the header line from the active
                                  Statement/Register.

            Sort ->
              By Date*            Sorts the active Check Register by date.
              By Number*          Sorts the active Check Register by check
                                  number.
              Date,Number*        Sorts the active Check Register by Date,
                                  then Number.

              Number,Date*        Sorts the active Check Register by Number,
                                  then Date.



                                             Page 10  WinCheck Owner's Manual



            Sort ->
              Checks by Date*     Sorts the check section of  the active
                                  Check Statement by date.

              Checks by Number*   Sorts  the check section of  the active
                                  Check Statement by number.
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            CHECKING

             Check                Activates the Write Check dialog for
                                  writing a new check.
             Deposit              Activates the Deposit dialog for recording
                                  a deposit transaction.
             Cash Machine         Activates the Cash Machine dialog for
                                  recording a cash machine withdrawal from
                                  your checking account.

             Misc                 Activates the Misc dialog for recording
                                  miscellaneous charges or credits to your
                                  checking account.
             Savings to Checking  Activates the Transfer Savings to Checking
                                  dialog in order to record transfers from
                                  your savings account to your checking
                                  account.
             Checking to Savings  Activates the Transfer Checking to Savings
                                  dialog for transferring money from your
                                  checking account to your savings account.
             Interest accrued     Activates the Checking Interest Accrued
                                  dialog, in order to record interest on
                                  your checking account.
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            SAVINGS

             Withdrawal           Activates the Savings Withdrawal dialog
                                  for recording withdrawals from your
                                  savings account.
             Deposit              Activates the Savings Deposit dialog for
                                  recording deposits into your savings
                                  account.
             Cash Machine         Activates the Savings Cash Machine dialog
                                  for recording a cash machine withdrawal
                                  from your savings account.

             Misc                 Activates the Misc dialog for recording
                                  miscellaneous charges or credits to your
                                  savings account.
             Savings to Checking  Activates the Transfer Savings to Checking
                                  dialog in order to record transfers from
                                  your savings account to your checking
                                  account.
             Checking to Savings  Activates the Transfer Checking to Savings
                                  dialog for transferring money from your
                                  checking account to your savings account.
             Interest accrued     Activates the Checking Interest Accrued
                                  dialog, in order to record interest on
                                  your checking account.

            TOOLBOX

             Displays the Icon-Based toolbox (mouse required).
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            WINDOW*

             The Window menu only appears once a Register or Statement
             window has be opened. Choose Display Check Register or Display
             Check Statement from the File menu in order to open a
             Register/Statement window.

             Cascade              Cascades the open Register/Statement
                                  windows (windows appear in a staggered
                                  stack).
             Tile                 Tiles the Register/Statement windows so
                                  that all open Register/Statement windows
                                  can be viewed at once.
             Arrange Icons        Arranges any minimized Register/Statement
                                  icons.

            COMMON

             Add ->               Allows for the creation of  common
                                  transactions:
                                  Check, Checking Deposit, Checking Misc.,
                                  Checking Interest accrued, Savings
                                  Withdrawal, Savings Deposit, Savings
                                  Misc., Savings Interest accrued.
                                  A common transaction is a transaction that
                                  is made on a regular basis, such as a car
                                  payment.  There is a maximum of 32 Common
                                  transactions allowed.
             Edit/Delete          Allows you to change or delete Common
                                  Transactions.

             Date/Transaction/$$$*These menu items represent the common
                                  transactions created with the Add menu
                                  choice. When you select a common
                                  transaction, the appropriate transaction
                                  dialog will appear. Pressing OK when the
                                  dialog is displayed, will record the
                                  transaction for the current month.
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            HELP

             Index                Displays the Index of the OnLine help
                                  information.
             Overview             Displays Overview information for
                                  WinCheck.
             Keyboard             Displays the Keyboard Controls for
                                  WinCheck.

             Commands             Displays information about the WinCheck
                                  Menu Commands.
             Help on Help         Activates the Microsoft Windows Index to
                                  Using Help.
             About                Displays the WinCheck About dialog.

          Keyboard short cuts:

            F1               Activates the OnLine Help Index.
            F2               Displays Current Balance.
            F3               Activates the Check dialog for writing a check.

            F4               Activates the Checking Deposit dialog to record
                             a checking deposit.
            F5               While in a Transaction Dialog, F5 will increase
                             the date in the date field (each time F5 is
                             pressed the date will increase by a day).
            F6               While in a Transaction Dialog, F6 will decrease
                             the date in the date field (each time F6 is
                             pressed the date will decrease by a day).
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          Dialog Boxes
            LOAD

             This allows you to load in another account.

             OK                   Loads new account.
             CANCEL               Does not load new account.

             Note:                Only one account can be loaded at a time.
                                  If the account is password protected, the
                                  user will be prompted for a password at
                                  this time.

            TRANSACTIONS

             These are the checks, deposits, cash machines items, etc.  Use
             the TAB key to move between fields.

             OK                   Adds the transaction.
             CANCEL               Does not add the transaction.
             ANOTHER              Adds the transaction and clears the edit
                                  fields so that another transaction of the
                                  same type can be made (i.e. another check
                                  can be written).
             DETAILS              Brings up the Transaction Details window
                                  that allows you to enter extra
                                  information.

             PRINT                If the transaction is a check, WinCheck
                                  will print the Check.
             Note:                A maximum of 16 transaction dialogs can be
                                  displayed at any one time.
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             The Type drop down listbox allows you to specify the category
             of the transaction.  By default, all transactions are Personal.
             To add more types, simply type the new type into the edit field
             of the drop down listbox. If the type already has been entered,
             it can be selected from the listbox.

             Exported files are divided by type.
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            PICK A MONTH

             This dialog appears when you open a Register or a Statement.
             Select the month and year you want to view.

             OK                   Opens the Register/Statement for the
                                  specified month and year.
             CANCEL               Does not open the Register/Statement.

            EDIT/DELETE
             Displays a listbox with the Common Transactions dialog.

             EDIT                 Edits the selected Common Transaction.

             DELETE               Deletes the selected Common Transaction.
             LEAVE                Exits this dialog.

             Hint:                Double Clicking on a Common Transaction
                                  entry can also be used to edit it from the
                                  list.
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            FIND Transaction

             Allows you to search for a string or types of transactions.

             Search Range     Determines the dates to search.
                                  Can be:

                                       Search Current Month Only
                                       Search ALL months
                                       Search from: fill in month/year ->
                                             month/year  (i.e. 10/90
                                  11/90).
             Trans:               Determines the transaction to search for
                                  (i.e. checking deposit).
             Type:                Determines the type of transaction
                                  (Personal, etc) to search for.

             Amount:              Determines the amount to search for.  If
                                  left blank, then the search will consider
                                  any amount (wildcard).
             Check #:             For checks only.  Indicate the check
                                  number to search for.  If left blank, then
                                  the search will consider any check number
                                  (wildcard).
             Keyword:             For checks and Miscellaneous transactions
                                  only.  If the keyword in the field is in
                                  the To line for a check, or the
                                  Description line of a Misc, the search
                                  will consider it (i.e. Barbie Doll).  If
                                  left blank, the search will consider all
                                  descriptions (wildcard).
             Search               Start the search.

             Cancel               Leave the Find Transaction dialog without
                                  searching.

             Hint:                The transactions found are summed.  Use
                                  this to figure out how much you spent on a
                                  certain thing by using clever search keys.
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            SETTINGS

             Allows you to choose the preferences for WinCheck.

             Register Sorting     Determines how to sort the Register.  This
                                  can be changed for each Register window at
                                  any time; this is purely the initial sort
                                  method.
             Statement Sorting    Determines how to sort the Statement.
                                  This can be changed for each Statement
                                  window at any time; this is purely the
                                  initial sort method.
             Check Type           Endstub checks have a different Tab field
                                  order than conventional checks.
                                  Otherwise, there is no difference.

             Headings             If checked, displays headings for the
                                  Register or Statement.
             Wallpaper            If checked, the transactions have a
                                  colorful texture (Color systems only).
             Toolbox on startup   If checked, the Toolbox appears when you
                                  start WinCheck (mouse systems only)
             Balance on startup   If checked, the Balance dialog appears
                                  when you load an account.

             Password Protection  If checked, the password entered in the
                                  edit fields is required to access the
                                  account.  The password must be the same in
                                  both fields.  Valid passwords are any
                                  string of characters up to 15 characters
                                  long.
             OK                   Saves preferences.
             CANCEL               Uses previous preferences.



                                             Page 20  WinCheck Owner's Manual



            CURRENT BALANCE (F2)

             Allows you to view your balance and the bank's current balance
             at any time except when in the WinCheck Form Designer.

            OK                   Close Balance window.
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            FORM ATTRIBUTES

             Lines Per Inch       This defines the number of lines per inch
                                  your form is designed for.  Almost every
                                  form is designed for 6 lines per inch (the
                                  default value).
             Chars per Inch       This defines the number of characters per
                                  inch your form is designed for.  Almost
                                  every form is designed for 10 characters
                                  per inch (the default value).
             Form Vert Size       This defines the number of lines for a
                                  single check.  For example, if you have a
                                  check that is 3.5 inches deep, and you are
                                  printing at 6 lines per inch, then your
                                  check would be 21 lines long.

             Form Horiz Size      This defines the number of inches wide
                                  your form measures.  Typically 8 inches
                                  (the default value).
             Forms Per Page       This defines the number of checks that fit
                                  on a single printer page.  A check queue
                                  will be the size of this number (valid
                                  range is 1-5).  As you print checks, this
                                  queue will fill up.  When the queue is
                                  full (or when you exit WinCheck), the
                                  queue will print.  This allows laser
                                  printer forms with three checks per page
                                  to print all three checks at once.  If you
                                  are using a dot matrix printer, you may
                                  find it annoying that a page eject is
                                  produced after printing a check.  This is
                                  a limitation of Windows.  Therefore, by
                                  specifying a number of checks per page,
                                  you can print a pageful of checks at a
                                  time, reducing the number of times you
                                  need to "wind the printer back".
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            CHECK FIELD ATTRIBUTES

             Chars Wide           This defines the number of characters wide
                                  the text field may be.
             Lines Deep           This defines the number of lines deep the
                                  field may be.  Generally, the field is one
                                  line deep, with the exception of the
                                  address field.  In this case, it should be
                                  four lines deep.
             Check Field Type     This allows you to define the type of text
                                  field.  There are eight standard fields,
                                  plus a custom field.  The standard fields
                                  will be automatically filled in when you
                                  print the check.  The custom field will
                                  print the text you enter in this dialog.
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            TRANSACTION DETAILS

             This dialog allows you to save additional information about a
             transaction.  Information entered in the memo line field(s)
             will be printed when printing checks.  Information entered in
             the address section will be printed on checks if an address
             field as included.

             Comments are not printed.
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            SPLIT TRANSACTION DIALOG

             Splitting a transaction takes place after you have pressed the
             OK or ANOTHER button on a transaction if the "Type" field
             displays "Split...".

             Amount Accted For    This is how much money has been assigned
                                  to a category.
             Amount Remaining     This is how much money is not assigned to
                                  a category.  This number must be 0.00 in
                                  order to leave the split dialog.
             ADD                  Assigns the amount in the edit field to
                                  the category in the Type field, and adds
                                  it to the list of assigned amounts.

             DELETE               If an amount is selected in the list, this
                                  will delete it.
             MODIFY               If an amount is selected in the list, this
                                  will replace it.
             HELP                 Brings up a help screen containing the
                                  information on this page.
             OK                   Accepts the list.

             For an example, please refer to the "How To" section of this
             manual.
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            EDIT CATEGORIES

             To edit categories, choose "Edit Categories" from the "File"
             menu.

             Select a category from the list.

             DELETE               Removes the category.
             MODIFY               Replaces the selected category with the
                                  category in the edit field.

             Note:                Deleting a category is a permanent
                                  decision.  Make sure that none of your
                                  transactions are still using this
                                  category.  WinCheck will not lose these
                                  transactions, but the reports will place
                                  these dollar amounts in a category titled
                                  "Deleted".

             Modifying a category will change that category description
             throughout your entire register.  For example, changing
             "Business" to "Pleasure" will affect every "Business"
             transaction in your account.

             It is not possible to delete or modify the category "Personal".
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            REPORT GENERATOR

             WinCheck has a report generator that allows for printing and
             viewing reports.  Bring up the Report Generator Dialog from the
             "File" menu.  Select the starting month of the report span,
             then select the ending month.  Select the report type you wish
             to view.

             Pressing the "View" button gives a quick look at the report on
             the screen.  It is not possible to page backwards through the
             report.

             Pressing the "Print" button prints the report on the printer
             specified in the Select Printer Dialog.

            SELECTING PRINTERS

             Choosing "Select Printer" from the "File" menu will bring up
             the Select Printers dialog.  For each type of printout (Checks,
             Reports), choose a printer.  When complete, press OK.  To use
             the default printer for everything, press USE DEFAULT, and then
             press OK.
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         Starting a New Account

          Setting up a WinCheck bank account is easy.  After starting the
          WinCheck program you are prompted for the account ID of the
          account which you would like to work with.  Valid account ID's are
          1-3 characters in length, only A-Z, 0-9 characters are allowed.
          To start a new account, type in an account ID that you have not
          used before.  Doing this will bring up a dialog asking to open a
          new account (click the OK button to start a new account with the
          specified account ID).
          Once a new account is started, the balance for checking and saving
          is $0.00.  To specify an initial checking account balance, choose
          Misc from the Checking menu.  Enter the starting balance amount in
          the Amount field and type "Starting Balance" in the Description
          field.  Check both the Credit account and Cleared boxes.  Click on
          the button marked Details or press ALT+D to access Details from
          the keyboard.  Press the TAB key six times to advance to the
          Comments section or click within the Comments section with the
          mouse.  In the Comments section, you can type any notes about a
          particular transaction.  In this case, you might want to type in a
          note indicating that this transaction is the initial checking
          account balance for WinCheck.  The other fields in the Details
          dialog are used to enter a mailing address and memo information
          for printing checks.  Once you have entered the comment, click OK
          to close the Details dialog and OK again to close the Checking
          Deposit dialog.

          To specify an initial Savings account balance, choose Misc from
          the Savings menu and type a beginning balance figure in the Amount
          field and type "Starting Balance" in the Description field.
          Next, you might want to add your paycheck amount to the Common
          menu so that each time you are paid, the amount can be entered in
          one step.  From the Common menu choose Add and select Checking
          Misc.  Enter the date you are paid, the amount, and type PayCheck
          in the Description field.  Check both the Credit account and
          Cleared boxes. Press OK to add the transaction to the Common menu
          for later access.
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         Using WinCheck

          Daily Activities

            Once you have started your account with WinCheck, there are a few
            activities you will do often:

            1.Enter checks you wrote while away from home.  This can be done
             by pressing F3, or by choosing Check from the Checking Menu.
            2.Create checks at home.  This can include bill paying, or other
             expenses.  WinCheck can print the checks on any available blank
             check that will fit in a printer.  WinCheck can keep track of
             up to 32 "Common Transactions", these transactions are those
             that happen on a repeat basis.  For example, payday can be
             entered as a common transaction, allowing you to make your
             payroll deposit with a single menu choice.  Also, bills can be
             automatically paid with a single menu choice.

            3.Enter deposits, transfers, or other transactions.

          Less Common Activities
            There are some other activities that you will not do as often:

            1.Reconcile and Balance your account.  Usually once a month, you
              can flag all of your banking transactions as cleared by your
              bank.  Afterwards, you can check you balance to the bank's
              balance, and as long as they match, your account is A.O.K.
            2.Create Common Transactions.  Here you can define a transaction
              that will happen on a repeat basis (i.e. Car Payment, etc).

            3.Create Check Form Templates, or load templates.  The WinCheck
              Form Designer allows you to create a template to print on
              anything that will fit in your printer!
            4.Print reports.  WinCheck's Report Dialog has a list of the
              types of reports available.

            5.Change WinCheck settings.
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         Transaction Types

          Transactions by default are of the type "Personal".  If you do not
          wish to separate your transactions by type, just leave the type in
          the "Type" field of a transaction dialog as "Personal".  However,
          if you wish to create new transaction types, such as "Business",
          "Utility", "Cats", etc, you can use the "Type" field to select
          one.  To add a new type to the list, just type it in; WinCheck
          will automatically add the type to the list.

          When you export your account to a file, the type field will be
          used to separate transactions.  Each column of information will be
          for a different type.
          Sample Exported File:

          CHECKING CREDITS

                                               Personal  Bills     Utility

          11/01/90         Checking Deposit    1000.00

          CHECKING DEBITS

                                               Personal  Bills     Utility

          11/01/90  #103   Phil's Cat Cabana   45.96
          11/12/90  #104   Pacific Power Company                   23.33
          11/07/90         Checking Cash Machine         60.00
          11/12/90         Credit Card Payment           250.00
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         Checks:

          Check Details:

            WinCheck can keep extra information about any transaction.  This
            information can be accessed by pressing the "Details..." button
            in the transaction dialog.  For this section, we will refer to
            the check dialog.

            The Transaction Details dialog provides for three pieces of
            information:
              1. Two memo lines.  These will be printed on the memo line of
                 a check (if your form includes a memo field(s)).

              2. An address.  This is the address of the recipient of the
                 check.  If you print the check, and use envelopes with a
                 window, you can have the address show through the window.
              3. Comments.  You can enter any information you want in this
                 field.  It will not be printed.

          Entering Checks you wrote away from home:

            WinCheck has dialogs for entering checks.  There are two slightly
            different variations: Conventional and Endstub.  The only
            difference between the two are the tab ordering of the fields.
            When entering in the data, the check number field will have the
            next available check number in it.  If you write your checks in
            order, you will not need to change this field.  The current date
            will be in the date field.  You can manually type in a new date,
            or you can use the F5 and F6 keys to move down or up a day,
            respectively.  The F5 and F6 keys only work while the blinking
            caret is in the date field.  If you enter an invalid date,
            WinCheck will prompt you for a correct date.  If you enter an
            invalid dollar amount, WinCheck will inform you of it's
            interpretation of the number.
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          Creating Checks at home:

            WinCheck can print checks to any blank check that fits in your
            printer.  Before printing checks, use the WinCheck Print Form
            Designer to design your check form.  Enter the information into
            the check fields as you would normally.  If you like a memo and
            address field printed on the check, be sure to add the
            information to the check with the Details dialog (a memo an
            address field will also need to be part of your form or it won't
            print the fields).  Make sure the details dialog has the address
            and memo line information you want.  Once this is OK, press the
            "Print" button from the check dialog.  If you are using a Check
            Print Queue, the check will be entered into the check printing
            queue.  If the queue is full, all of the checks in the queue will
            be printed.  Pressing "Print" will also save the check into the
            data file (the equivalent of pressing the OK button).  If you
            want to print a previously entered check, double click on the
            check entry from the check Register or Statement.

          Common Checks:

            If you add checks to the Common Transactions, you should also
            enter the check details such as an account number for the memo
            field and a recipient address.  This way, when you actually write
            checks at home from the Common menu, the check details will be
            automatically filled in.  By using the Common Check and details,
            paying a bill is as simple as a Menu Choice, a push of the
            "Print" button, a signature, and sealing the envelope!
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         Deposits:

          There are two ways to make a deposit to your account.  You can
          choose "Deposit" from the Checking or Savings menus, or you can
          choose "Misc" from the Checking or Savings menu.  If you choose
          "Misc", you can describe the type of deposit (i.e. "Direct
          Deposit", or "Bank Credit").  Be sure to check the "Credit
          Account" box on the Misc dialog, otherwise the amount will be
          deducted from your balance instead of credited.
          Take advantage of the Common Transactions to put your paychecks
          and other direct deposits using the Deposit or Misc transaction
          types.

          For both the Deposit and Misc dialogs, if you press F5 or F6 while
          on the Date field, you will move the date up or down one day,
          respectively.

         Cash Machine:

          The cash machine allows you to indicate cash machine withdrawals.
          You can indicate common withdrawal amounts of cash, or you can
          type in the exact amount you withdrew.  Note that these
          transactions are automatically flagged as "Cleared" by WinCheck.
          This is because the transaction was done electronically through
          your bank and thus clear immediately.  To unclear a transaction,
          use the Register or Statement.
          If you press F5 or F6 while on the Date field, you will move the
          date up or down one day, respectively.

         Transfers:

          You can indicate transfers of funds from checking to savings or
          vice versa.  Enter the amount and date in the fields.
          If you press F5 or F6 while in the Date field, you will move the
          date up or down one day, respectively.
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         Interest:

          If your checking account or savings account accrues interest, you
          can enter the amount with this dialog.  Enter the amount and date
          in the fields.
          If you press F5 or F6 while in the Date field, you will move the
          date up or down one day, respectively.

         Miscellaneous:

          If none of the transaction types suit your needs, you can make up
          your own transaction here.  Type the description of the
          transaction into the Description field, and enter the date and
          amount.  If the transaction adds money to your balance, check the
          "credit account" box.  By default, this is not checked.

          If you press F5 or F6 while in the Date field, you will move the
          date up or down one day, respectively.
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         The Register:

          The Check Register can be used for many different operations:
            1.Reconciliation of transactions.

            2.Deletion of transactions.
            3.Modification of transactions.
            4.Changing transactions from one date to another.
            5.Viewing your running balance.

            6.Finding Transactions (although you can use the Find function).
          The Register Appearance:

            The Register is a window with a caption (header) and a listbox.
            The caption indicates the columns and the information each one
            provides.  The Header Line will only appear if the Headings box
            is checked in the Settings dialog.  The Register window can be
            minimized, sized, closed, or arranged with the Window menu option
            on the Main Window.

            Multiple Registers and Statements from the same or different
            months can be open at once.  Opening the same Register twice can
            be helpful for comparing different parts of the month to each
            other.  Opening a register from two different months can be
            helpful for comparing months' transactions.  The Window menu
            lists the open windows and can be used to jump from one window to
            another.
            If an asterisk appears by the dollar amount or date on the
            transaction, this indicates that it has been cleared by the bank.

            For both checking and savings, there are two columns for your
            running balance.  The Checking has "ChkBal" and "BnkChk" columns.
            "ChkBal" indicates your balance.  This is updated with every
            transaction you make.  In a idealistic system where all
            transactions instantly clear the bank, this would be your true
            running balance.  However, banks are usually a few days behind in
            clearing transactions, hence the "BnkChk" column.  Only those
            transactions that are cleared will show up in this column.
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            The Register listbox is a Multiple Selection listbox.  To select
            one item, click on it (or use the arrow keys to move to it).  To
            select a block of items, use the shift key and arrow keys, or
            click and drag the mouse.  This could be helpful to clear a group
            of checks at one time when your bank statement arrives.  To
            select non-contiguous transactions, use the control key and mouse
            or arrow keys.  Consult your Windows User Manual for more
            information on Multiple Selection Listboxes.

            The number of Register windows open at one time depends on the
            amount of memory your system has available.
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          Reconciliation of Transactions:
            To reconcile (clear) a transaction(s), select it, and then choose
            "Clear" from the Data menu.  Once cleared, these transactions
            will now have an asterisk beside them, and the "BnkChk" column
            will update to reflect the Bank's balance.  When you have
            reconciled every transaction that your bank knows about, compare
            the "BnkChk" balance with the Bank's balance.  If they match up,
            you have a balanced account!

            Pressing the F2 key will bring up the current balances of your
            account.

          Deletion of Transactions:

            To delete a transaction, select it, and then choose "Delete" from
            the Data menu.  Be sure you really want to do this, as the data
            cannot be undeleted.

          Modification of Transactions:
            To modify a transaction(s), select the transaction(s), and double
            click the mouse, or press the Enter key.  The transaction(s) will
            appear on the screen in their respective dialogs so the
            information can be edited.  You can have a maximum of 16
            transaction dialogs open at any one time.

          Changing Transactions from one Date to Another:

            Edit the transaction, and change the date.  WinCheck will then
            automatically move it to the new place in the register (if sorted
            by date).

          Viewing your Running Balance:

            You can view your running balance with the Register.  For a most
            accurate reflection, you should set the sorting to be by Date.
            This can be done from the "Sort" option in the Data menu.
            NOTE:            Each window has it's own sort options.
                             Changing the sorting option for one window does
                             not change the sorting option for another
                             window.
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         The Statement:

          The Check Statement can be used for many different operations:
            1.Reconciliation of transactions.

            2.Deletion of transactions.
            3.Modification of transactions.
            4.Changing transactions from one date to another.
            5.Finding Transactions (although you can use the Find function).
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          The Statement Appearance:
            The major difference between the Register and the Statement is
            the range of items displayed.  The Register displays the items as
            they would be in your check register.  The Statement displays
            items as they would appear on a Bank statement.  Deposits are
            first, then checks, then other transactions.  Register Windows
            display transactions for a month.  Statement windows display
            transactions for a month long cycle (i.e. Jan 15 through Feb 15).
            The "Settings" option under the File menu allows you to specify
            the start of the bank cycle.

            The Statement is a window with a Header and a listbox.  The
            Header indicates the columns and the information each one
            provides.  The Statement window can be minimized, sized, closed,
            or arranged with the Window menu option on the Main Window.
            It is completely OK to have more than one window open of the same
            month.  This can be helpful comparing different parts of the
            month to each other.

            If an asterisk appears by the dollar amount or date on the
            transaction, this indicates that it has been cleared by the bank.
            If the "Display Uncleared" option is checked on the Data Menu,
            then only those transactions that have yet to clear the bank will
            appear.  This is useful for the "Elimination Method" of
            reconciliation.

            For both checking and savings, there is a column for the
            transaction amount.
            The Statement listbox is a Multiple Selection listbox.  To select
            one item, click on it (or use the arrow keys to move to it).  To
            select a block of items, use the shift key and arrow keys, or
            click and drag the mouse.  To select non-contiguous transactions,
            use the control key and mouse or arrow keys.  Consult your
            Windows User Manual for more information on Multiple Selection
            Listboxes.
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          Reconciliation of Transactions:
            To reconcile (clear) a transaction(s), select it, and then choose
            "Clear" from the Data menu.  These transactions will now have an
            asterisk beside them, and the "BnkChk" column will reflect the
            Bank's balance.  When you have reconciled every transaction,
            press the F2 key to bring up the balances of your account.  If
            you have the "Display Uncleared" menu option checked, the cleared
            transactions will not be displayed.

          Deletion of Transactions:

            To delete a transaction, select it, and then choose "Delete" from
            the Data menu.  Be sure you really want to do this, as the data
            cannot be undeleted.

          Modification of Transactions:

            To modify a transaction(s), select the transaction(s), and double
            click the mouse, or press the Enter key.  The transaction(s) will
            appear on the screen in their respective dialogs so the
            information can be edited.  You can have a maximum of 16
            transaction dialogs open at any one time.

          Changing Transactions from one Date to Another:
            Edit the transaction, and change the date.  WinCheck will
            automatically move it to the new place in the Statement (if
            sorted by date).

          Finding Transactions:

            View the Statement and locate the transaction or use the Find
            Transaction function for quicker results.

            NOTE:            Each window has it's own sort options.
                             Changing the sorting option for one window does
                             not change the sorting option for another
                             window.
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         Finding Transactions:

          To find a transaction, the easiest method is to choose the
          "Find..." option from the File menu.  Here you can fill in a
          search key to find your transaction.  You can make the key as
          detailed or vague as you wish.  You can also specify the search
          range to be either the current month, all months, or a range of
          months.
          Once you have pressed the OK button, WinCheck will display all of
          the transactions it finds in a listbox.  If no transactions are
          found, the listbox will be empty.  Double clicking on the
          transaction or pressing the "view" button will display the
          transaction dialog.  Pressing the "View & Register" button will
          display that transaction, and open the appropriate Register.

          Pressing "Leave" will exit the Find function.

         Common Transactions:

          There are many transactions that you make on a regular basis:
          PayCheck deposits, Bills, Direct Payments.  WinCheck will keep a
          record of these transactions, and add them directly to the Common
          menu.  You can have up to 32 Common Transactions per account.
          To add a common Transaction, choose "Add" from the Common Menu.
          Decide the type of transaction you wish to add.  Fill in as many
          or as few fields as you wish.  Be sure to add details to this
          transaction if you want them to be added every time you make this
          transaction.

          Once you have added a transaction to the Common List, you can then
          view it on the Common menu.  Choosing the menu item will bring up
          a new transaction, with the fields already filled in.  However,
          the date and the check number (when applicable) will reflect the
          current date and the next available check number.  The details of
          the transaction will also have any details you entered in the
          common transaction.
          To Edit or Delete a common transaction, choose the Edit/Delete
          option from the Common menu.  Select the transaction, and push the
          Edit or Delete button.  When you are done, press the Leave button.
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         Exporting Files

          To Export a file, choose "Export" from the File menu.  This menu
          option will only be available if a check Register is open and
          active.  A file with a extension of the Account ID is created in
          your WinCheck directory.  The file is saved in a tab delimited
          text format which is readable by most spreadsheet programs such as
          Microsoft Excel, 1-2-3, etc.
          The filename consists of EXPmmyy.iii, where:

          mm               The Month of the exported register.
          yy               The Year of the exported register.

          iii              The Account ID.

          Example:         EXP0990.TUT,  for September, 1990 Month, account
                           TUT.
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         Settings

          WinCheck has a few settings that are individual to an account.
          These can be obtained by bringing up the Settings dialog from the
          File menu.

         Register Sorting     When you open a new Register, this is the way
                              it will sort the information initially.  You
                              can change the sorting for that particular
                              window from the menu bar (Data... Sort).  If
                              the Headings box is checked, the headings
                              caption will be displayed in the Register
                              window.
         Statement Sorting    When you open a new Statement, this is the way
                              it will sort the information initially.  You
                              can change the sorting for that particular
                              window from the menu bar (Data... Sort).  If
                              the Headings box is checked, the headings
                              caption will be displayed in the Statement
                              window.

         Check Type           This defines your check type (Regular or
                              Endstub).  The only difference is the tab
                              ordering of the data fields.
         Transaction WallpaperIf checked, a pattern will appear for each
                              transaction (color systems only).

         Toolbox on Startup   If checked, the Toolbox, an icon-based command
                              menu, will appear when you start WinCheck
                              (mouse systems only).
         Balance on Startup   If checked, your current balance will be
                              displayed when you start WinCheck.

         Password Protection  If checked, you are prompted for a password
                              when loading the account.
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         WinCheck Form Designer:

          The WinCheck form designer allows you to create or edit forms to
          print checks.
          There are several options you can do from the Form Designer:

           1.  Create a new template.  Choose "New" from the File Menu to
               create a new template.
           2.  Load a form template.  This will set your default printing
               template also.  Choose "Load" from the File Menu.
           3.  Save a form template.  This will save the template on the
               screen.  It will not add it to your list of templates.  If
               this template already exists in your list, it will update the
               file.

           4.  Save a form template and add it to your list.  This will save
               the template, and allow you to give it a "human" description.
               When you load templates, you can load by description.
           5.  Change the form attributes.
           6.  Print a test form.  You can use this to determine if your
               form is printing correctly.
           7.  Edit a template.
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          Form Attributes:
            A form describes one check.  If you have three checks per page,
            you still want to describe the properties of only one check.

          Lines Per Inch       This defines the number of lines per inch the
                               template is designed for.  Typically, you
                               should leave this as six lines per inch.

          Characters Per Inch  This defines the number of characters per
                               inch the template is designed for.  Typically
                               you should leave this as 10 characters per
                               inch.
          Form vertical size   This defines how many lines deep your check
                               is.  If your check is three and one half
                               inches deep, and you are using 6 lines per
                               inch, then your check would be 21 lines deep.
          Form Horizontal size This defines how wide the form is.  Usually
                               eight inches wide, but some forms may be
                               wider.
          Forms per page       This defines the size of the Check Printing
                               Queue.  This should reflect the number of
                               checks per page.

          Check Printing Queue:

          Windows is not capable of printing part of a page.  Windows
          expects an entire page to be printed at a time.  To overcome this
          limitation, WinCheck has a check queue.  As you select the "Print"
          button from checks, WinCheck will add them to the Check queue.
          When the check queue is full (i.e. a page is full), then the
          entire page will print.
          On some printers, you can change the page size.  Check with
          Windows Control Panel to see if your printer supports this.  If
          your printer can accept a page size change, then you can change
          the size of the page to reflect the size of the check.  In this
          case, it is possible to leave "forms per page" to 1, and have each
          check print individually.
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          Editing the form:
            You can edit the form on the workspace with the mouse only.  A
            text field is a block on the form that indicates the area in
            which information can be printed.  A text field has many
            attributes (see Text field attributes).

            Clicking and dragging the text field moves it.  Double clicking
            on a text field will bring up the text attributes.
            Pressing the Delete key while the cursor is over a field will
            delete it.

            Pressing the Insert key will insert a new text field at the
            cursor location.

          Text Field Attributes:

            The text field has the following properties:

            Chars Wide       This defines how many characters wide the field
                             can be.
            Lines Deep       This define how many lines deep a field can be.
                             It is recommended that this value be set to 1
                             for all fields except the address field, which
                             should be four lines deep.

            Check Field Type This defines what information will be in the
                             field.  If the field is set to "Text", then you
                             can place characters in the field that will
                             print on the form.
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         Printing Your First Check

          Printing the first check is the most work.  Almost all of this
          work can be avoided by purchasing a check that matches the
          included check templates.  The "Default LaserJet" template will
          print on the NEBS B9039-1 General Purpose Laser Check.  NEBS can
          be reached at 1-800-225-9550.  The "Default Epson" template was
          designed to print on the checks enclosed with the "Quicken"
          software package.
          Here are the steps that should be taken when you get ready to
          print checks the first time:

           1.  Purchase computer check forms from your favorite dealer.
           2.  Start up WinCheck, but do not put the forms in your printer
               yet.
           3.  If you are using a supported form, choose "Load Form
               Template" from the WinCheck Form Designer (Activated by
               choosing "Check Form Printer Setup" from the "File") menu.
               Step 4 should not be necessary.

           4.  If you want to create a new check form, choose "New Form
               Template" from the WinCheck form designer.  Create the fields
               to fill in your check (double clicking the right button on
               the mouse adds a new field, or press the insert key).
               Describe the attributes of the field(s).  Double clicking
               with the left button on an already existing field will allow
               you to edit the attributes.  Double clicking with the left
               button on the "workspace" of the WinCheck form designer will
               allow you to describe you form attributes.  Form attributes
               describe the size of one check.  If you are using a laser
               printer, describe the full page (unless your check form has
               multiple checks per page).  If you are using a dot-matrix
               printer, describe one check.  If three checks fit on a page,
               you can indicate this.
           5.  Once you have described the "rough draft" (or loaded in an
               existing template), print a test form on plain paper.  Hold
               the test form against your check form and make sure all of
               the fields line up (you can use a lightbulb to see through
               the papers).  Click and drag fields to line them up.
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           6.  Repeat step 5 until your rough draft is OK.  If you have not
               saved this template before, choose "Save & Add" from the
               WinCheck form designer.  Describe your template however you
               want, and pick a filename.  If you have previously saved your
               file, just choose "Save".
           7.  Now you are ready to print checks!
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         Password Protection

          WinCheck allows for password protection of data.  In the settings
          Dialog Box, check the Password Protection box, and enter the same
          password in both edit fields.

          For your safety, Wilson WindowWare will not assist users in
          recovering data due to forgotten or lost passwords.
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         Tips & Techniques

          Take advantage of the Misc transaction.  Direct Deposits,
          automatic withdrawals, service fees, and more can be entered here.
          Take advantage of the Type field in the Transaction dialogs. You
          can accurately and carefully track your finances this way.  For
          example, you can break transactions out to be Personal or
          Business, Taxable or Non Taxable, or whatever your imagination
          decides.  Other types fields could be rent, entertainment,
          shareware registration, utilities, or teenager expenses.

          Use the Common Transactions to the fullest!  Bill paying can be
          just a few keystrokes or mouse clicks away.  By using the Misc
          transaction for everything except checks, you can have detailed
          descriptions on the menu bar.
          Generally, it is a good idea to only reconcile when your bank
          statement arrives.  This way you can use the Display Uncleared
          (from the data menu) to make sure you have not forgotten to enter
          any transactions.  Once no transactions appear, you should be done
          balancing (everything has cleared the bank).

          Take advantage of the Transaction Details.  You can put account
          numbers or other important information on the memo line for added
          security.  If you purchase envelopes with windows, you can have
          the recipients address printed on your check so it views through
          the window.  Take advantage of the Comments section so you can
          look back later.
          When you create form templates, please feel free to distribute
          them everywhere.  Many other users would love to have pre-defined
          forms.  A good description would be the form inventory number and
          manufacturer.

          Forms are device independent as long as you leave the lines per
          inch and characters per inch settings at their defaults (6 LPI and
          10 CPI).
          Register this product!  By registering this product, you will keep
          informed about updates, and you will keep me motivated to make
          more nifty windows apps.
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         How To

          Here is a list of How-To steps for many common actions with
          WinCheck.

          Starting a new Account

            Please refer to the Section "Starting a New Account".

          Entering Checks written while away from home

            Example:You go shopping at the grocery store, pick up some
                    videos at the video rental outlet, and you have an
                    espresso at the coffee shop.
            1. Select "Check" from the menu or Toolbox.

            2. Fill in the fields for the grocery store, and indicate the
               amount.  When the fields are complete, press the ANOTHER
               button.
            3. Repeat step 2 for the video store.

            4. Repeat step 2 for the coffee shop, except press the OK
               button.
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          Setting up WinCheck for Bill Paying
            1. If your periodical bill (i.e. monthly, weekly, etc) is not on
               the Common menu, choose "Add" from the Common Menu.

            2. If you pay your bill by check, choose "Check" from the Add
               menu.  If you pay you bill electronically (such as automatic
               payments), choose "Misc" from the Add menu.
            3. Fill in the fields to indicate the appearance of the bill.
               If the dollar amount varies for each time you get the bill,
               fill in the dollar amount for 0.00 or leave it blank.

            4. If the transaction is the "Misc" type, fill in the
               description.
            5. If the bill falls into a category other than "Personal",
               choose the category.

            6. If the bill is paid by check, and you print your own checks,
               fill in the Details dialog.  By indicating the address and
               account number of the bill, you can avoid having to enter it
               in the future.
            7. Choose OK from the transaction.  The bill will not be on the
               Common menu.
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          Paying Bills
            1. If your periodical bill is not on the Common Menu, consider
               adding it (see above section, "Setting up WinCheck for Bill
               Paying").

            2. If you print checks, load your printer with the check forms,
               and note the check number.  Otherwise, skip steps 3, 4 and 5.
            3. If your bill is on the Common menu, select the bill, adjust
               the amount (if necessary), and press the PRINT button.

            4. If your bill is not on the Common menu, select "Check" from
               the menu or toolbox, fill in the fields, and press the PRINT
               button.
            5. Repeat steps 3 and 4 until your bills are paid.  Ignore steps
               6-8.

            6. If you bill is on the Common menu, select the bill, adjust
               the amount (if necessary), and press the OK button.
            7. If your bill is not on the Common menu, select "Check" from
               the menu or toolbox, fill in the fields, and press the OK or
               ANOTHER button (depending if you have more bills).

            8. Repeat steps 6 and 7 until your bills are paid.
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          Your Bank Statement Arrives
            1. Open up a Statement window for the month.  If you have
               transactions from the previous month that did not clear, you
               may need to open last month's Statement window also.  Choose
               "Display Statement" from the File menu.

            2. Choose "Display Uncleared Only" from the Data menu for each
               Statement Window.  For example, if you have January and
               February's statements, activate January by clicking the mouse
               on it (or from the Window menu), and then choose Data...
               Display Uncleared.  Do the same steps for February.
            3. You will see a list of the transactions that have not yet
               cleared the bank.  The ordering should closely math your bank
               statement.  You may need to change the sorting order, this
               can be done through the File menu.

            4. Compare the transactions on the bank's statement with your
               statement to make sure the amounts agree.  If the amounts
               disagree, either contact your bank, or change your amounts to
               reflect the bank's statement.
            5. Once the amounts agree, select the transactions that are on
               the bank's statement.  You can select multiple transactions
               by holding down the CTRL key while selecting.

            6. Choose "clear" from the Data menu.
            7. Repeat steps 4-6 until all of the transactions on the bank's
               statement have been indicated.

            8. Enter in your bank's service fees, if any.
            9. Check your balance by either opening a register, or by
               pressing F2.  The Bank's balance should match up.  If you
               have made deposits that have not cleared, they may reflect on
               this balance.  If you have, it will be necessary to open the
               register to examine the bank's balance on the closing day of
               your statement.
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          Payday!
            1. If your paycheck(s) are on the Common menu, choose them, and
               press OK.  You are done!

            2. Otherwise, consider adding your payroll to the Common menu.
               If you are using direct deposit, you could use the "Misc"
               transaction to indicate this.  Make sure that you check the
               "Credit" box on the Misc transaction to indicate that this
               transaction is adding money to your account.

          A night on the town

            Example:You head downtown, withdraw $50 from the cash machine,
                    write a check for dinner, and withdraw another $50 for
                    late night dancing.
            1. Select "Cash Machine" from the Menu or Toolbox.  Indicate the
               dollar amount and press ANOTHER to enter your second "hit" on
               the cash machine.  Note that your bank's balance is updated
               immediately for cash machine withdrawals.  To change this,
               uncheck the "Cleared" box before pressing the ANOTHER key.

            2. Indicate the dollar amount for the second withdrawal, and
               press OK.
            3. Enter your check for dinner.



                                             Page 55  WinCheck Owner's Manual



          Splitting a Transaction
            Example:You have written a check to your stockbroker for
                    $1000.00.  Of this amount, $500 is for stock, $250.00 is
                    for a money market, and $250.00 is for a margin call.

            1. Enter the check for $1000.00 and make sure that the type
               field displays "Split...".
            2. Press OK or ANOTHER to bring up the split Dialog.

            3. Type "500.00" into the amount field, and select "Stock" in
               the type field.  If this category does not exists, type the
               word "Stock" into the field.
            4. Press ADD.

            5. Type "250.00" into the amount field, select "Money Mkt" (or
               type it in), and press ADD.
            6. Do the same for "Margin".

            7. Press OK.
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         Appendix A:  WinCheck Messages

          The following is a list of WinCheck messages and their meanings.

         Message(s)             Meaning
         Too many open          WinCheck can display
         Transactions.          up to 16 transaction
                                dialogs
                                simultaneously.
                                However, only one new
                                transaction is
                                allowed.

         Not Enough Memory.     WinCheck requires
         Close some             about 256K of memory
         Registers/Statements,  to run efficiently.
         and try again.

         Too low on memory to
         do anything (xxx
         Bytes). Close some
         registers/statements/
         other apps and try
         again.

         Limit Reached on       WinCheck can keep
         Common Transactions    track of 32 Common
                                Transactions.

         There is no data to    WinCheck will not
         search.                search, or display
                                registers/statements/
         There is no data to    reports until a
         calculate.             transaction has been
                                entered.
         There is no data to
         password protect.

         Too many matches!      WinCheck can display
                                up to 100 matches
                                during a search.
                                Matches over 100 are
                                not displayed.  The
                                "total" figure,
                                however, is accurate.
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         The date is            Example: 03/09/91
         incorrect. Please use
         MM/DD/YY format.

         Negative Sign          WinCheck
         Unnecessary.           automatically adds or
                                subtracts the amount
                                from the register.
                                In the case of
                                Miscellaneous
                                transactions, use the
                                "Credit" checkbox to
                                indicate deposits to
                                your account.

         Warning: $.$$$         WinCheck rounds
         changed to $.$$        transactions to the
                                penny.

         Invalid ID- Please     WinCheck must have an
         use characters and     account ID of 1-3
         numbers only.          characters, A-Z, 0-9
                                only.

         Unknown Data Type.     Your data files my be
         Using Default Data     corrupted.  Check
         Type                   your register.

         Error While Printing   Refer to your Windows
         Printing Aborted       owner's manual for
                                printing problems.

         Please do not enter a  All WinCheck
         file extension.        templates must have
         WinCheck will          .WCT as the
         automatically add      extension.
         .WCT to the filename
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         Unable to access       An error occurred
         printer driver. Check  while loading the
         to make sure the       Windows Printer
         printer is active via  Driver.  Consult your
         Control Panel          Windows Owner's
                                manual for printing
         Failure to Load        problems.
         Printer DLL

         Failure to Access
         Printer DLL

         Added Check to Check   WinCheck has queued
         Print Queue            up this check for
                                printing.  It will
                                print it when the
                                queue is full, or
                                when you exit
                                WinCheck.

         All money must be      When splitting
         accounted for.         transactions, the sum
         Number must be less    total must equal the
         than or equal to       total amount of the
         amount available       transaction.

         WARNING: Deleting a    WinCheck wants to
         category can leave     make sure all your
         transactions with      money is categorized
         unresolved             in other areas.
         categories. Continue?  Otherwise, WinCheck
                                reports will have
                                amounts under the
                                category "Deleted".

         Field(s) blank on      WinCheck will use
         transaction. Discard?  $0.00 for a blank
                                amount field.

         Only one new           WinCheck allows only
         transaction allowed    one new transaction
         at a time. Please      to be entered at a
         complete the current   time to help avoid
         new transaction.       confusion.
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         Password and Verify    WinCheck wants to
         Fields do not match.   make sure your typed
                                your password
                                correctly.
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         Appendix B:  License Information

                                       WinCheck
                         Copyright c 1990, 1991 by Dave Edson
                                 All rights reserved.

                                   SOFTWARE LICENSE

         WinCheck is not and has never been public domain software, nor is
         it free software.

         Non-licensed users are granted a limited license to use WinCheck on
         a 21-day trial basis for the purpose of determining whether
         WinCheck is suitable for their needs.  The use of WinCheck, except
         for the initial 21-day trial, requires registration.  The use of
         unlicensed copies of WinCheck by any person, business, corporation,
         government agency or any other entity is strictly prohibited.

         A single user license permits a user to use WinCheck only on a
         single computer.  Licensed users may use the program on different
         computers, but may not use the program on more than one computer at
         the same time.

         No one may modify or patch the WinCheck executable files in any
         way,  including but not limited to decompiling, disassembling, or
         otherwise reverse engineering the program.

                                      (more...)
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         A limited license is granted to copy and distribute WinCheck only
         for the trial use of others, subject to the above limitations, and
         also the following:

         1) WinCheck must be copied in unmodified form, complete with the
         file containing this license information.

         2) The full machine-readable WinCheck documentation must be
         included with each copy.

         3) WinCheck may not be distributed in conjunction with any other
         product with out a specific license to do so from Wilson
         WindowWare.

         4) No fee, charge, or other compensation may be requested or
         accepted, except as authorized below:

         A) Operators of electronic bulletin board systems (sysops) may make
         WinCheck available for downloading only as long as the above
         conditions are met.  An overall or time-dependent charge for the
         use of the bulletin board system is permitted as long as there is
         not a specific charge for the download of WinCheck.

         B) Vendors of user-supported or shareware software approved by the
         ASP may distribute WinCheck, subject to the above conditions,
         without specific permission.  Non-approved vendors may distribute
         WinCheck only after obtaining written permission from Wilson
         WindowWare. Such permission is usually granted.  Please write for
         details (enclose your catalog).  Vendors may charge a disk
         duplication and handling fee, which, when pro-rated to the WinCheck
         product, may not exceed eight dollars.

                                      (more...)
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                                   LIMITED WARRANTY

         Wilson WindowWare guarantees your satisfaction with this product
         for a period of 90 days from the date of original purchase.  If you
         are unsatisfied with WinCheck within that time period, return the
         package in saleable condition to the place of purchase for a full
         refund.

         Wilson WindowWare warrants that all disks provided are free from
         defects in material and workmanship, assuming normal use, for a
         period of 90 days from the date of purchase.

         Wilson WindowWare warrants that the program will perform in
         substantial compliance with the documentation supplied with the
         software product.  If a significant defect in the product is found,
         the Purchaser may return the product for a refund.  In no event
         will such a refund exceed the purchase price of the product.

         EXCEPT AS PROVIDED ABOVE, WILSON WINDOWWARE DISCLAIMS ALL
         WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
         TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
         PARTICULAR PURPOSE, WITH RESPECT TO THE PRODUCT.  SHOULD THE
         PROGRAM PROVE DEFECTIVE, THE PURCHASER ASSUMES THE RISK OF PAYING
         THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION
         AND ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES.  IN NO EVENT WILL
         WILSON WINDOWWARE BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING
         WITHOUT LIMITATION DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
         INTERRUPTION, LOSS OF BUSINESS INFORMATION AND THE LIKE) ARISING
         OUT OF THE  USE OR THE INABILITY TO USE THIS PRODUCT EVEN IF WILSON
         WINDOWWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

         Use of this product for any period of time constitutes your
         acceptance of this agreement and subjects you to its contents.

                                      (more...)
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                          U.S. GOVERNMENT RESTRICTED RIGHTS

         Use, duplication, or disclosure by the Government is subject to
         restrictions as set forth in subdivision (b)(3)(ii) of the Rights
         in Technical Data and Computer Software clause at 252.227-7013.
         Contractor/manufacturer is Wilson WindowWare
         2701 California Ave SW /suite 212/ Seattle, WA 98116

                                      TRADEMARKS

         IBM, PC/XT, PC/AT, and PS/2 are registered trademarks of
         International Business Machines Corporation.

         Microsoft and MS-DOS are registered trademarks of Microsoft
         Corporation.
         Windows is a trademark of Microsoft Corporation.

         Pagemaker is a trademark of Aldus Corporation.

         PubTech and BatchWorks are registered trademarks of
         Publishing Technologies, Inc.

         BARBIE is a registered trademark of Mattel, Inc.

         Command Post is a trademark of Wilson WindowWare.

         WinCheck is a trademark of Dave Edson
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